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1. Overview

1.1 Benefits

	 • Easy Backup of
		  1. Windows System State
		  2. Outlook and Outlook Express (i.e. *.pst, *.dbx and *.wab)
		  3. Important personal settings, e.g. Desktop, Favorite, My Documents and History etc
	 	 4. Other common files (e.g. *.doc, *.xls)
	 • Support of backing up only changes within a file (using in-file delta technology)
	 • Support of backing up of open files on Windows XP/2003 (Volume Shadow Copy)
	 • (New in 5.1.0.6) Support of backing up of Windows NTFS access privileges.
	 • Easy to use, deploy and maintain

1.2 Features

	 • User configurable incremental / differential in-file delta backup mode (i.e. backing up only changes within a 
	 	 file since last incremental backup (or last full backup) according to each user’s preferences) 
	 • Allow in-file delta backup mode to be overridden by each user individually according to backup time (e.g. 
	 	 enforcing full (or incremental or differential) backup of all files on every Sunday or the 1st day of every 
		  month) 
	 • Single mail level exchange backup (brick level exchange backup) 
	 • Volume Shadow Copy backup (i.e. backing up files even when they are exclusively open, e.g. Outlook.pst)
	 • Bandwidth Throttling at backup account level (new) In-File Delta backup (i.e. backing up only changes 
	 	 within files)
	 • Off-line backup mode and logout backup reminder
	 • Real time backup server replication allows backup server to be easily backup
	 • Customizable backup schedule allows backup to be scheduled at any time 
	 • Compress and encrypt data automatically before sending them to the server (server stores only encrypted 
		  data)
	 • Increment backup strategy ensures that only new or updated files (or changes with last backup file) are 
		  sent to backup server
	 • Can integrate with external “Open File Manager” to provide open file backup support to all open files
	 • Access backup data anytime, anywhere by using a browser
	 • Comprehensive backup report lists all files being backup. Backup report will be delivered to user 
		  automatically via email when each backup job completed. 
	 • Backup data are CRC validated before they are stored on server.
	 • Fully user customizable data retention policy allows users to have access to deleted files using the least 
		  possible storage space on server
	 • Select files to be backed up easily by using backup filter, e.g. selecting all *.doc and *.xls in your computer 
		  in a single operation
	 • Run any custom OS commands before/after a backup job.
	 • Periodic backup files validation on backup server ensures backup files are 100% valid and fully restorable 	
		  when needed.

1.3 Security

	 • 128-bit point-to-point SSL communication between server and client
	 • Support HTTP/HTTPS Proxy and Socks v4/v5 firewall 
	 • Data are 128-bit encrypted when stored on backup server
	 • Choice of different encryption algorithms, e.g. Twofish, Triple DES, Advanced Encryption Standard (AES)
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	 • Choice of different encryption modes, e.g. Electronic Cook Book (ECB) and Cipher Block Chaining (CBC)
	 • An random initializing vector, salt and iteration count will be generated by the software automatically for 		
	 	 each file when encrypting your data
	 • Each backup user can restrict online access to his files to his pre-defined list of IP addresses

1.4 System Requirements

	 • Operating System:
	 	 Windows 95 / 98 / ME / NT / 2000 / XP / 2003
	 • Memory: 128MB (minimum), 256MB (recommended)
	 • Disk Space: 100MB 
	 • Network Protocol: TCP/IP (http/https)
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2 DataMate Configuration
	 Before you can start backing up to the DataMate Server, you need to install DataMate onto your computer. 

2.1 Installation

	 Please follow the instructions below to install DataMate onto your computer. 

		  i.	 Click the [Install Software] link available at the top of the [Online Backup Services Management 		
			   Console]

		  ii.	 Select the operating system to which you want to install DataMate

		  iii.	Follow the instructions on the installation guide to complete DataMate installation

	 Notes on Windows Installation
	 A quick launcher is now installed in the system tray (next to your system clock). To open DataMate, just 		
	 right click the quick launcher icon  and choose [Open]. 

2.2 Upgrade

	 This section describes the software upgrade instructions required to upgrade DataMate to the latest 		
	 release.

	 Upgrade instructions of DataMate on Windows
	 Download the latest installer (obm-win.exe) from the web installation guide and install it over existing 		
	 installation of DataMate. It will upgrade the DataMate to the latest version

	 Note:
	 You will only be prompted to reboot your computer if some files are locked and cannot be overwritten during 	
	 upgrade.

2.3 Un-installation

	 This section describes the steps required to uninstall DataMate from your computer.

	 Uninstallation instructions of DataMate on Windows
	 a. Open [Start] -> [Control Panel]  -> [Add/Remove Programs]
	 b. Select [DataMate] from the list and press the [Remove] button
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3 Using DataMate
	 This chapter will describe all features available in DataMate and outline how you can use the features of 		
	 DataMate to meet various backup needs.
 

3.1 System Tray Launcher

	 After you have successfully installed DataMate to your computer, an OBM icon will be added to the system 	
	 tray area (next to your system clock) automatically. 

	 This icon is the entry point to DataMate. Right clicking the icon will show a menu that provides the 			
	 following functions:

Menu Item What it does

Open Run DataMate

Backup
Run the backup set (or all backup sets) chosen in the sub-menu in 
background

Backup and Logoff
Run the backup set (or all backup sets) chosen in the sub-menu in 
background and logoff from Windows

Backup and Restart
Run the backup set (or all backup sets) chosen in the sub-menu in 
background and restart Windows

Backup and Shutdown
Run the backup set (or all backup sets) chosen in the sub-menu in 
background and shutdown this computer

Help Show a help dialog

Stop running backup
Interrupt the running backup set (or all backup sets) chosen in the sub-
menu

Exit Close this system tray launcher application

3.2 Logon Dialog

	 Before you can use DataMate, you have to be authenticated by the DataMate Server first. The 	 	 	
	 logon dialog shown below will check if you have the right to access DataMate by submitting the username 		
	 and password you provided to the backup server.

	 For secure communication, you can choose to communicate with DataMate Server in SSL 				 
	 (Secure Socket Layer) by selecting the [https] option. 
	 The [Address] field shows the DataMate Server to which DataMate will connect to authenticate 	 	 	
	 your username and password. You can use either a resolvable host name.

	 If you need to connect to the server through proxy, just enter your proxy setting in the [Proxy Setting] 		
	 section. For [SOCKS] proxy, both v4 and v5 without user authentication are supported.

3.3 User Profile

	 After the backup server authenticates you successfully, DataMate main window appears. You can then use 	
	 DataMate to update your user profile.
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	 You can perform the following update to your user profile.
	 To change your [Password], press the [Change] button next to the password field. A Change Password 	 	
	 dialog will appear. Enter your original password and new password into the text field of this dialog and press 	
	 [OK]. 

	 To change your [Display Name], press the [Change] button next to the display name field. A Change Display 	
	 Name dialog will appear. Enter the new display name and press [OK]. 

	 To change your [Time Zone], just select your time zone from the drop down list next to the time zone entry. 
	 To add a new contact email to this account, press the [Add] button in the [Contact] section. A [Add New 		
	 Contact] dialog will appear. Enter a name and an email address in the text field provided and then press the 	
	 [OK] button.

	 To remove a contact email, select the email that is to be removed from the email list and press the [Remove] 	
	 button. Press [OK] to confirm the removal.
	 To update a contact email, select the email that is to be updated from the email list and press the 			 
	 [Properties] button. A [Update Contact Property] dialog will appear. After you have made the changes that 		
	 you want, press the [OK] button.

3.4 Backup Logs

	 All backup activities are logged to backup activity log files. They are available for reviewing from DataMate.

	 How to review backup activities?
	 You can review all your backup jobs by 

		  i.	 Select the [Log] tab available at the bottom of DataMate

		  ii.	 Select the Backup Job you want to review on the [Log Controller] panel
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4 Setting up backup set
	 A backup set contains all backup settings of a backup operation. This section will describe all features 		
	 available within a backup set and explain how you can use each of them to achieve various tasks. 

	 Each backup account can have multiple backup sets. Each backup set is an individual and independent 		
	 entity. For example, if you want one directory to be backed up during the day and another directory to be 		
	 backed up during the night, you can create two backup sets, each with a different backup 				 
	 schedule and backup source, to serve this need. 

4.1 Backup Set Type

	 A backup set can be of one of the following types:

Backup Type Description

File Backup set type to backup common files/directories

	 Backup set type is defined at backup set creation and cannot be modified. If you want to change the 	 	
	 backup set type, you have to create another backup set. 

4.2 Backup Source

	 A backup source defines the files/directories that are to be included in a backup set. There are two types 	 	
	 of backup source: Selected and Deselected. Selected backup source defines files/directories that are to 	 	
	 be included in a backup set while deselected backup source defines files/directories that are to be excluded 	
	 from a backup set. Online Backup Manager will generate appropriate backup source setting for you 		
	 automatically when you make your backup source selection on DataMate.

	 From the [Standard] node available at the top of the [Backup Source] tree, you can easily select the following 	
	 common folders to be backed up:

		  1.	 “My Documents” folder
		  2.	 “Outlook” and “Outlook Express” mail store folder
		  3.	 “Favorites” folder
		  4.	 “Desktop” folder
 
	 From the [Options] node available below the [Standard] node, you can easily select other common folders to 	
	 be backed up as well. They include the “Application Data” folder, the “Start Menu” folder, the “Templates” 		
	 folder, the “All Users’ Documents” folder, the “Temporary Internet Files” folder, the “Cookies” folder, the 		
	 “Font” folder, the “History” folder, the “Applications Data” folder, the “Nethood” folder, the “Printhood” 		
	 folder, the “Recent” folder and the “Send to” folder.

	 The checkbox next to the files/directories shown above can be in one of the following mode:
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Mode Description

All files/directories (recursively) under this directory will be backed up

All files/directories (recursively), except those explicitly excluded, under this directory 
will be backed up. If you add files/directories to this directory in the future, they will be 
backed up as well.

Only the checked files/directories under this directory will be backed up. If you add 
files/directories to this directory in the future, they will NOT be backed up.

Nothing under this directory will be backed up.

4.3 Backup Schedule

	 A backup schedule defines the frequency and the time backup will run automatically.

	 Backup schedule can be in one of the following types:

Type Description

Daily Backup jobs will run everyday

Weekly Backup jobs will run on the specified day(s) of every week

Monthly
Backup jobs will run on the specified day or on a day with a given criteria (e.g. first 
weekend, last weekday) of every month

Custom Backup job will run once on any particular date

	 For each type of schedule above, backup will run at scheduled time for a maximum of the duration specified 	
	 (or until all data are backed up if [Stop on backup completion] option is chosen). If a backup job does not 		
	 finish within the maximum duration specified, it will be interrupted.

	 Please note that you can have more than one schedule within a backup set. For example, you can have 		
	 a daily backup schedule that runs at 13:00 at noon and another daily backup schedule that runs at 00:00 		
	 at midnight. The combination of both of these schedules effectively creates a backup schedule that runs 		
	 daily at 00:00 and 13:00 everyday.

4.4 In-File Delta

	 Please refer to the in-file delta section for more information on this topic. 

4.5 Backup Filter

	 A backup filter defines the file selection rules that allow user to easily include/exclude files into/from the 	 	
	 backup set by applying user defined criteria(s) to the file names or directory names.
	 There are some basic rule regarding backup filters:

	 	 i. Filters are checked in creation order. Once inclusion/exclusion has been identified, the remaining filters 	
			   won’t be checked.
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	 	 ii.	 Inclusion/Exclusion made by filter always takes precedence over backup source selections

	 	 iii.	If all filters do not apply to a particular file, this file is then checked for inclusion/exclusion backup 	 	
			   source selections

Key Description

Name The name of a filter

Top Directory
The top directory to which this filter is applied. Filtering rules will be applied to all 
files and/or directories under this directory.

Apply To Define whether to apply the filtering rule to files and/or directories

Pattern Matching

It defines the filtering rules of a filter. A filtering rule can be of one of the following 
types:

[Start With]	              Include/Exclude all files/directories with name starting       
                                       with a certain pattern. 
                                       For example: You can use B* to match all files with 
                                       name starting with a ‘B’ character

[Contain]	              Include/Exclude all files/directories with name 
                                       containing a certain pattern. 
                                       For example: You can use *B* to match all files with 
                                       name containing with a ‘B’ character

[End With]	              Include/Exclude all files/directories with name ending 
                                       with a certain pattern. 
                                       For example: You can use *.doc to match all files with 
                                       name ending with ‘.doc’ (all Word documents)

[Regular Expression]	 Include/Exclude all files/directories with name matching 
                                       a regular expression. 

Filter Mode

Defines whether you want to include or exclude matched files into/from the 
backup set. Also, for those unmatched files, you can choose to exclude (if 
include filter type) or include (if exclude filter type) them into/from the backup 
set. 

	 Example 1:
	 If you want to backup only Word, Excel and PowerPoint documents in your document directory (e.g. C:\My 	
	 Documents), you should setup your backup filter as follows.
	 Top Directory 			  = C:\My Documents 
	 Apply To 				    = File (true)
	 Matching Type		  = End With
	 Matching Patterns	= *.doc, *.xls, *.ppt
	 Filter Mode 			   = Include
	 Exclude all others 	= True
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	 Example 2:
	 If you want to backup all files, excluding all *.exe, *.dll and *.tmp, in C:\Applications, you should setup your 		
	 backup filter as follows.
	 Top Directory 			  = C:\Applications
	 Apply To 				    = File (true)
	 Matching Type		  = End With
	 Matching Patterns	= *.exe,*.dll, *.tmp
	 Filter Mode 			   = Exclude
	 Include all others 	= True

	 Example 3:
	 If you have made your selection of files (all under C:\) from the backup source setting but you want exclude 	
	 all images (e.g. *.jpg and *.gif) from your selection, you should setup your backup filter as follows.
	 Top Directory 			  = C:\ 
	 Apply To 				    = File (true)
	 Matching Type		  = End With
	 Matching Patterns	= *.jpg, *.gif
	 Filter Mode 			   = Exclude
	 Include all others 	= false

	 Please note that the [Include all others] setting is not enabled because you don’t want to include all other 		
	 files (NOT *.jpg, *.gif) under C:\ into the backup set.

	 Example 4: (advanced)
	 If you want to include everything, except the “log” directory, under C:\Applications into a backup set, you 		
	 should setup your backup filter as follows.
	 Top Directory 			  = C:\Applications
	 Apply To 				    = Directory (true)
	 Matching Type		  = Regular Expression 
	 Matching Patterns	= ^log$
	 Filter Mode 			   = Exclude
	 Include all others 	= True

	 Example 5: (advanced)
	 If you want to include all directories named “log” from the backup set files with file name starting with “B” 	 	
	 and ending with “*.doc” under C:\My Documents into the backup set, you can use a regular expression of 		
	 “^B.*\.doc$” to do your selection. The filter backup can then be setup as follows.
	 Top Directory 			  = C:\My Documents
	 Apply To 				    = File (true)
	 Matching Type		  = Regular Expression 
	 Matching Patterns	= ^B.*\.doc$
	 Filter Mode 			   = Include
	 Exclude all others 	= True

4.6 Pre/Post-Backup Command

	 The command line tool feature has two major components, the [Pre-Backup] command and the [Post-		
	 Backup] command. You can use the [Pre-Backup] or [Post-Backup] commands to run any native OS 		
	 (operating system) commands before or after running a backup job. 

	 Both [Pre-Backup] and [Post-Backup] commands comprise of the following parameters: 
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Key Description

Name Name of this Command

Command
The command to be run 
(e.g. C:\My Documents\Application.exe or C:\My Documents\BatchJob.bat)

Working Directory The directory at which this command will run

	 The backup set type affects the time at which [Pre-Backup] and [Post-Backup] commands run. The 		
	 following table outlines when [Pre-Backup] and [Post-Backup] commands will run in different types of 		
	 backup set.

Backup Set Type When Pre-Backup Commands run? When Post-Backup Commands run?

File  Before uploading backup files After uploading all backup files

Non-File Backup 
Sets (e.g. Microsoft 
SQL Server)

Before spooling backup files to 
temporary directory

After spooling backup files to temporary 
directory (i.e. before the first backup file is 
uploaded)

	 Note: You should never backup an application while it is running as this can result in inconsistent and 		
	 unusable files getting backed up. Please use the Pre-Backup Command feature to shutdown your 		 	
	 application before running a backup job and use the Post-Backup Command feature to restart your 		
	 application after the backup job has completed.

4.7 Encryption

	 Before your files are sent to DataMate Server, all your files are to be compressed and encrypted 	 	 	
	 by your choice of encrypting algorithm, mode and key. The following table explains all encryption 			 
	 parameters available within a backup set.
	
	 Note:
	 Encryption settings are set at backup set creation time and cannot be modified. You need to create a new 	 	
	 backup set if you want to change your encryption settings for a backup set.

Parameter Description

Encryption Algorithm

It defines the encrypting algorithm used to encrypt your backup files. There 
are three encryption algorithms available: 

[AES]	Advanced Encryption Standard algorithm
[DESede]	 Triple DES algorithm
[Twofish]	 Twofish algorithm

We recommend the use of AES as it has been chosen as the encryption 
standard for commercial use. Please refer to references on Cryptography 
for more information on this area.
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Encryption Mode

It defines the encrypting mode used to encrypt your backup files. There are 
two encryption modes available: 

[ECB]	 Electronic Cook Book Mode
[CBC]	 Cipher Block Chaining Mode

We recommend the use of CBC mode as it offers better security. Please 
refer to references on Cryptography for more information on this area.

Encrypting Key
The key used to encrypt all files within a backup set. Please write it down 
on paper and keep it in a safe place. If the key is lost, you will not be 
able to recover your files from the encrypted backup files.

4.8 Retention Policy

	 During backup, if DataMate finds out that you have deleted a file (or updated a file) on your computer, it will 	
	 put the corresponding deleted (or updated) file already backed up on the backup server into a retention 	 	
	 area. The retention policy setting defines how long files inside the retention area will be kept on the backup 	
	 server before they are deleted automatically from the server.
	 Retention policy will only affect “retained” file (i.e. files that have already been deleted or updated on your 	 	
	 computer and thus are moved to the retention area of the backup server). For those files that have not been 	
	 updated on your computer, the backup of these files is kept in the data area on the backup server and won’t 	
	 be affected by the setting of retention policy. These backup files of unchanged files will stay on the backup 		
	 server forever until the original files are removed (or updated) from your computer.

	 Standard Retention Policy

	 The [Standard] retention policy allows you to delete retained files automatically after a user defined number 	
	 of days or after a user defined number of backup jobs. To change the retention policy setting of any backup 	
	 set, please select the [Retention Policy] node on the left panel. You can then make changes to your retention 	
	 policy under the [Retention Policy] section. After you have made your changes, just press the [Save Setting] 	
	 button on the toolbar.

	 Advanced Retention Policy

	 The [Advanced] retention policy allows you to configure a more flexible retention policy. It allows you to keep 	
	 a set of snapshots of all backup files based on the time of the backup jobs. For example, you can configure 	
	 the advanced retention policy to keep the following sets of backup files to mimic the retention policy back 	 	
	 from the old days when you were still doing tape rotations:

	 • All files available within the last 7 days
	 • All files available on the last 4 Sundays within the last 28 days
	 • All files available on the 1st day of each month within the last 3 months
	 • All files available on the 1st day of each quarter within the last 12 months
	 • All files available on the 1st day of each year within the last 7 years

	 To do so, you need to setup your advanced retention policy as follows: 

	 • Type = Daily; Number of copy to keep = 7 
	 • Type = Weekly; Frequency = Sunday; Number of copy to keep = 4
	 • Type = Monthly; Frequency = Day 1; Number of copy to keep = 3
	 • Type = Quarterly; Frequency = Day 1 of Jan, Apr, Jul, Oct; Number of copy to keep = 4
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	 • Type = Yearly; Frequency = Date 01-01; Number of copy to keep = 7

	 Assuming today is 17-Jan-2006, if [Remove retention files for overlap policy] is NOT enabled, a total of 25 	 	
	 snapshots (7+4+3+4+7, provided you have run backup daily for more than 7 years already) will be kept on 		
	 the server accordingly, i.e.: 

	 • Daily: 10-Jan-2006, 11-Jan-2006, 12-Jan-2006, 13-Jan-2006, 14-Jan-2006, 15-Jan-2006, 16Jan-2006
	 • Weekly: 24-Dec-2005, 31-Dec-2005, 7-Jan-2006, 14-Jan-2006
	 • Monthly: 1-Nov-2005, 1-Dec-2005, 1-Jan-2006
	 • Quarterly: 1-Jan-2005, 1-Apr-2005, 1-Jul-2005, 1-Oct-2005
	 • Yearly: 1-Jan-2004, 1-Jan-2003, 1-Jan-2002, 1-Jan-2001, 1-Jan-2000, 1-Jan-1999

	 If [Remove retention files for overlap policy] is enabled, only the following snapshots are kept:

	 • Daily: 14-Jan-2006, 15-Jan-2006, 16-Jan-2006
	 • Weekly: 7-Jan-2006
	 • Monthly: 1-Nov-2005, 1-Dec-2005, 1-Jan-2006
	 • Quarterly: 1-Jan-2005, 1-Apr-2005, 1-Jul-2005, 1-Oct-2005
	 • Yearly: 1-Jan-2004, 1-Jan-2003, 1-Jan-2002, 1-Jan-2001, 1-Jan-2000, 1-Jan-1999

	 The weekly policy overrides the daily policy so the snapshots of 10-Jan-2006, 11-Jan-2006, 12-Jan-2006 		
	 and 13-Jan-2006 are removed. The monthly policy overrides the weekly policy so the snapshots of 24-Dec-	
	 2005, 31-Dec-2005 and 7-Jan-2006 are removed as well. The same applies to the quarterly and yearly 		
	 policy but because there is no other overlapping of the dates above, the snapshots of dates specified by the 	
	 monthly, quarterly and yearly policy remains the same.

4.9 Extra Backup (Off-line backup, Logout Reminder)

	 Off-line backup is basically designed for notebook users who are off-line most of the time and cannot rely 		
	 on backup schedule to backup regularly. The “Backup Interval” allows notebook users to specify the interval 	
	 that they would like their data to backup. If this interval has elapsed, backup will run automatically once this 	
	 machine is online. The “Off-line Notification Day” setting is the number of days after the off-line backup 	 	
	 interval when the backup server will send email notification to the client to remind him to run an off-line 	 	
	 backup.

4.10 Network Mapped Drive

	 If you need to backup a network-mapped drive on Windows (it will only work in Windows NT/2000/XP/2003), 	
	 you must enter your Windows domain, username and password into the [Network Resources Authentication 	
	 for Windows] section as shown below. It is required because scheduled backups will always run under 		
	 the context of windows LocalSystem account (which does not have the privilege required to access 		
	 network resources) by default. DataMate need to collect your Windows username, password and domain 		
	 name to authenticate itself to the windows domain controller to acquire the required access privileges to 		
	 the network files which are to be backed up. If you don’t supply a username and password, DataMate will 	 	
	 have problem accessing network resources in its scheduled backup jobs.

	 If you need to backup network mapped drive in scheduled backup, please do this:

		  i.	 Select the backup set from the left panel and press the [Properties] button 
		  ii.	 Enter your Windows domain, username and password into the dialog shown below
		  iii.	Press the [Save Setting] button on the toolbar



B A C K U P  S E R V I C E S

S E C U R E  O F F S I T E  D A T A  B A C K U P

User’s Guide v2.01

DataMate Backup Services Pty Ltd - January 22, 2008 13

	 The steps above apply only to computers running in a Windows domain. If you don’t have a windows 		
	 domain with your network and you are using a workgroup or using a NetWare server instead, please 		
	 use the “net use” command to authenticate the running backup process against the computer hosting the 		
	 mapped drive. Otherwise, you will get “Access Denied” error from the backup report.

	 For example, if you want to backup \\SERVER\SHARE that is located on a NetWare server (or another 		
	 computer is a windows workgroup) and you are getting “Network drive is not accessible” error message, 		
	 please try adding the following command as a [Pre-backup command] 

	 net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]\[USERNAME]

	 E.g.
	 C:\> net use \\Netware\Data password /USER:peter
	 C:\> net use \\WorkgroupComputer1\Data password /USER:WorkgroupComputer1\peter

	 This will authenticate the current process with the NetWare server (or another computer is a windows 		
	 workgroup). Backup will then be allowed to run correctly.

4.11 Local Copy

	 If you want to save an extra copy of backup data on your local disk (in addition to a copy of backup data 		
	 stored on the backup server) to minimize file-restoring time and/or to provide an extra safety precaution, you 	
	 can do the following:

		  i.	 Open DataMate from the System Tray (see previous sections for details)
		  ii.	 Setup your backup set (see previous sections for details)
		  iii.	Select [Local Copy] under your backup set from the left panel 
		  iv.	Check the [Copy to Local Hard Disk] checkbox
	 	 v.	 Enter a directory to where you want an extra copy of your backup files to be stored in the [Copy to] 	 	
	 	 	 field provided (preferably a directory under another hard disk)
	 	 vi.	(Optional) Select the [Yes] radio button if you want to store your backup files in compressed form to 	 	
			   conserve free space usage
		  vii.	An extra copy of backup will be saved in the [Copy to] directory when you run your backup job 

	 If you want to make local copy to a directory located on a NetWare server (or another computer is a 		
	 windows workgroup) and you are getting “Network drive is not accessible” error message, please try adding 	
	 the following command as a [Pre-backup command] 

	 net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]\[USERNAME]
	
	 E.g.
	 C:\> net use \\Netware\Data password /USER:peter
	 C:\> net use \\WorkgroupComputer1\Data password /USER:WorkgroupComputer1\peter

	 This will authenticate the current process with the NetWare server (or another computer is a windows 		
	 workgroup). Backup will then be allowed to run correctly.

	 How to restore “Local Copy” files
	 “Local copy” files are stored in the [Copy to] directory (under [Local Copy] setting) in encoded filenames (A 		
	 “.nozip” extension is appended to all filenames if [Zip] setting is not enabled. A “.zip” extension is appended 	
	 to all filenames if [Zip] is enabled). To restore backup files back to their original filenames (and to their 	 	
	 original contents if [Zip] is enabled), please do the followings:



B A C K U P  S E R V I C E S

S E C U R E  O F F S I T E  D A T A  B A C K U P

User’s Guide v2.01

DataMate Backup Services Pty Ltd - January 22, 2008 14

		  i.	 Choose [Tools] -> [Unzip Local Copy]
		  ii.	 Select the required [Backup Set] from the drop down list
	 	 iii.	Fill in the [Source Directory] (directory where “Local Copy” files are stored) and [Destination Directory] 	
	 	 	 (directory to where you want “Local Copy” files to be restored)
		  iv.	Completed

4.12 Multiple Computers using one backup account

	 If you want to backup multiple computers using a single backup account, you need to create different 		
	 backup sets to backup each individual computer. Also, for each installed copy of DataMate, you must 		
	 configure DataMate so that it only runs scheduled backup for its intended backup sets on its computer. If 	 	
	 this is not being setup properly, scheduled backup job of the same backup set from different computers will 	
	 both be started. This will result in lots of checksum errors and files being deleted on the backup server.

	 To allow multiple computers to be backed up under a single backup account, you are required to do the 		
	 following for each computer that has been installed with DataMate under the same backup account:
	
		  i.	 Logon to one of the computers that has been installed with DataMate under the same backup account
		  ii.	 Open DataMate and select a backup set that is not intended to run on this computer from the left 		
			   panel
		  iii.	Uncheck the [Run scheduled backup on this computer] checkbox on the right panel
		  iv.	Repeat the previous step for the rest of all backup sets that are not intended to run on this computer
		  v.	 Repeat step ii to step iv for each computer that has been installed with DataMate under the same 		
			   backup account

	 IMPORTANT If you want to backup an extra computer using the same backup account some time later (this 	
	 implies that you need to create an additional backup set under this backup account for the new computer), 	
	 please make sure to repeat the procedure above (unchecking the [Run scheduled backup on this computer] 	
	 checkbox for the added backup set) for each computer

4.13 Transfer Block Size

	 Transfer block size defines the block size DataMate will use to transfer your backup blocks. Generally, 	 	
	 backup job using a larger block size would have a better performance, as there will be less roundtrip 		
	 involved in connection initialization. 

	 However, some firewalls or proxy servers may block out-going network traffic (HTTP/HTTPS POST method) 	
	 with large block size for security reasons. If you are in a network with this type of restriction, please lower the 	
	 transfer size value and try again.

	 To change the transfer block size of any backup set, please select the [Setting] node on the left panel to 		
	 invoke the [Setting] panel on the right. You can then make changes to the [Transfer Block Size]. After you 		
	 have made your changes, just press the [Save Setting] button on the toolbar.

4.14 Temporary directory

	 If you are running a file backup job with in-file delta enabled or a database type backup job, temporary files 	
	 will be generated by the backup job and directory that will be used to store all these files are defined by 	 	
	 [Setting] -> [Temporary directory for storing backup files]. Please set this to a non-system disk partition that 	
	 has enough free space to avoid problems.
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	 You can set the [Temporary directory for storing backup files] to a network mapped drive. If you choose to 	 	
	 do this, please use a UNC path (e.g. \\SERVER\SHARE) or don’t forget to configure the [Backup Set] -> 	 	
	 [Network Resources Authentication for Windows] setting.

	 To conserve the use of disk space, you can use the [Remove temporary files after backup] option to delete 		
	 the temporary files automatically after a backup job has finished.

4.15 Microsoft Volume Shadow Copy (VSS)

	 Microsoft Volume Shadow Copy Service (VSS) allow you to backup files that are exclusively opened. 	 	
	 Without VSS, you will get the error message “The process cannot access the file because another process 		
	 has locked a portion of the file” if you are trying to backup a file that is exclusively opened (e.g. Outlook PST 	
	 file). 

	 Please note that VSS is only available on Windows XP / 2003 and you must have administrative privileges to 	
	 start the VSS service on a computer.

	 If you are running Windows 2003, please install the Windows 2003 VSS hot fix available in http://support.	 	
	 microsoft.com/default.aspx?scid=kb;en-us;887827 before running VSS.

	 If you are running into problem with running VSS on Windows XP, Microsoft’s recommendation is to try re-	 	
	 registering the Volume Shadow Copy Service again. Simply run the script [DataMate Home]\bin\			 
	 RegisterVSS.bat to do so.

	 For more information, please take a look at the following page for a technical introduction to Volume 		
	 Shadow Copy Services (VSS):

	 http://technet2.microsoft.com/windowsserver/en/library/2b0d2457-b7d8-42c3-b6c9-59c145b7765f1033.		
	 mspx



B A C K U P  S E R V I C E S

S E C U R E  O F F S I T E  D A T A  B A C K U P

User’s Guide v2.01

DataMate Backup Services Pty Ltd - January 22, 2008 16

5 Backing up files
	 This chapter describes how files are backed up by DataMate to the backup server

5.1 How files are backed up

	 Run backup at scheduled time automatically
	 Once you set your backup scheduled, a backup job will be started automatically to perform backup 		
	 operation for you at your absence. You can have backup running at your scheduled time as often as you 		
	 want (e.g. twice a day or hourly during office hour) without requiring doing any extra work.

	 Incremental Backup
	 Unchanged files are already backed up to server and need not to be backed up again. DataMate will 	 	
	 pick the new or updated files from your backup set files and upload only these files to the server. It 		 	
	 significantly reduces the time required to perform the backup operation since most users update less than 		
	 5% of their total data each day.

	 Compress and encrypt data automatically
	 Data are compressed and encrypted before they are uploaded to the server. Not only does it reduce the 		
	 storage space to keep you backup files, it also ensures the privacy of your data.

	 File Retention Policy
	 The built-in file retention policy allows you to access multiple versions of the same file or even deleted 	 	
	 files from your backup set. Backup files are put into a retention area before they are removed from the 	 	
	 server. If you want to get back a deleted file (or you want to get back the previous versions of an updated 	 	
	 files) within the retention period, these files will always be available in the retention area. This feature is 	 	
	 particularly useful when you have accidentally deleted a file or incorrectly updated a file within the file 	 	
	 retention period (file retention period is user customizable). 

5.2 Backup files directly to the backup server

	 You can backup your data to an DataMate Server by following instructions below.
		  i.	 Open DataMate

		  ii.	 Right click DataMate icon available in the system tray and choose [Open]

			   a.	 Create a backup set
			   b.	From the Menu, Choose [Backup Set] -> [New] -> [File Backup Set]
			   c.	 Enter a name for your backup set
	 	 	 d.	Select the files/directories you want to backup
			   e.	 Set the backup schedule (Note: You can have more than one schedule in a backup set)
			   f.	 Set the encryption algorithm, encryption mode and encrypting key for this backup set
				    (Hint: For the sake of simplicity, just select the [Default] radio button (your encrypting key is set to 		
				    be the same as your backup account password)

		  iii.	Run Backup 

	 	 	 a.	 Select the backup set you want to run on the left panel and press the [Start Backup] button (►) on 	 	
				    the toolbar
	 	 	 b.	Select [Off-site Backup Server] to start backing up your files to an DataMate Server.
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	 Note: 
		  1.	 You can have more than one backup set in backup account.
		  2.	 Please write the encrypting key down on paper and keep it in a safe place. If you lost your encrypting 	
	 	 	 key is lost, you will not be able to restore your backup files.

5.3 Backup files to removable hard disk (seed loading)

	 If you have a lot of data (e.g. 300GB) to backup to the backup server, it would take a considerable amount 		
	 of time to perform the first full backup through the Internet. If you run into this problem, you can use the 	 	
	 Seed Loading Utility to backup your backup set to local hard disk (instead of directly to the backup 		
	 server) and then transport the backup data, using removable hard disk, to the offsite backup server. 		
	 The administrator can then load all your backup files from your removable hard disk into your backup 	 	
	 account. This could then save you days (even weeks) of performing your first full backup. Since subsequent 	
	 backup will be incremental backup (only new or updated files will be uploaded to the server), you should 	 	
	 have no problems finishing backing up all files afterwards. 

	 To perform seeding loading, please do the following:

		  i.	 Open DataMate from the System Tray (see previous sections for details)

		  ii.	 Setup your backup set (see previous sections for details)

	 	 iii.	Select the backup set you want to run on the left panel and press the [Start Backup] button (►) on the 	
			   toolbar

	 	 iv.	Select [Local Hard Disk (Seed Load Utility)] to start backing up your files to local hard disk and press 		
			   the [OK] button

	 	 v.	 Enter a directory where you want all backup files to be stored in the [Destination Directory] field and 	 	
			   press the [Start] button. 
	 	 	 Please make sure you have enough free space in the directory specified. If you are going to transport a 	
			   removable hard disk to the offsite backup server, please enter a directory under your removable hard 		
			   disk here.

	 	 vi.	You should get the message “Backup Completed Successfully” as shown below after all backup files 	
	 	 	 are spooled to the directory you specified. 

	 	 vii.Transport the data specified in the [Destination Directory] field to the offsite backup server
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6 Restoring files
	 This chapter describes different ways files can be restored from to the backup server

	 It is important to write down your encrypting key on paper and keep it in a safe place because there will be 	
	 no ways to restore your backup files if you lose your encrypting key.

6.1 Restore backup files directly from backup server

	 You can use either DataMate or the web restorer to restore backup files from the backup server.

	 Using DataMate
	 You can restore your data from the backup server DataMate by following instructions below.
		  i.	 Open DataMate from the System Tray (see previous sections for details)

		  ii.	 Select the [Restore] tab at the bottom part of DataMate 

	 	 iii.	Select the backup set from which you would like files to be restored from the left panel

	 	 iv.	Select the snapshot of your backup files that you would like to restore from the backup server by using 	
	 	 	 [Show files after Job] drop down list

	 	 v.	 Select the files that you would like to restore and press the [Restore Files] button on the toolbar

	 	 vi.	Use the [Browse] button to select the directory to where you want files to be restored (or simply select 	
	 	 	 [Original location] to restore files to their original path)

	 	 vii.	Files will be restored automatically as shown below (a file won’t be downloaded from the backup 	 	
	 	 	 server again if an identical file exists on local path already)

	 Using the web interface
	 You can backup your data to an DataMate Server by following instructions below.

		  i.	 Logon to the DataMate Server web interface

		  ii.	 From the top menu, click [File Explorer] 

	 	 iii.	Click the [Backup Set] link that contains the files that you want to restore

	 	 iv.	Select the snapshot of your backup files that you would like to restore from the backup server by using 	
	 	 	 [Show files after Job] drop down list

	 	 v.	 If you want to see all different versions all files (shown as gray below), just choose the [Show all files] 		
			   radio 	button on the [File Explorer] page. 

			   Files, which are shown in gray and marked as deleted below, e.g. dell.img (delete), are being stored in 	
	 	 	 the retention area on the backup server but you can still restore these files from the backup server.

	 	 vi	 .Select the files that you would like to restore and press the [Restore] button on the toolbar
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		  vii.	A dialog shown below would appear

			   a.	 Press the [Restore] button 
	 	 	 b.	Enter the directories to which backup files should be restored in the [Restore File to] textbox 
	 	 	 c.	 Enter the encrypting key which will be used to decrypt your backup files upon restoring your 	 	
	 	 	 	 backup files
			   d.	Press the [Start] button

6.2 Restore backup files from removable hard disk

	 If you want to restore lots of backup files from the backup server and you find it too slow to restore all your 		
	 backup files from the backup server through the internet. You can ask your backup services provider to 	 	
	 send you all your backup files in removable hard disk (or CD/DVD). However, all backup files stored on 	 	
	 backup server are in encrypted format. You need to decrypt them back to their original format before you 		
	 can use them. To decrypt your backup files from removable media, please do the followings:

		  i.	 Open DataMate from the System Tray 

		  ii.	 Select the [Tools] -> [Decrypt Files Wizard] from the menu

	 	 iii.	Use the [Browse] button to locate the “files” directory (provided by your backup provider in removable 	
	 	 	 hard disk or DVD) which contains the backup files that you want to decrypt 

	 	 iv.	If you have more than one backup set under the “files” directory, select the [Backup Set] which 	 	
	 	 	 contains the backup files that you want to decrypt 

	 	 v.	 Select the snapshot of your backup files that you would like to restore from the removable media by 	 	
	 	 	 using [Show files after Job] drop down list

	 	 vi	 .If you want to see all different versions all files (shown as gray below), just choose the [Show all files] 		
			   radio button on the [Decrypt Files Wizard] dialog. 

			   Files, which are shown in gray and marked as deleted below, e.g. dell.img (delete), are being stored in 	
	 	 	 the retention area on the removable media (but you can still restore these files).

	 	 vii.	Enter the directories to which you want backup files to be restored in the [Decrypt Files to] section and 	
			   enter the [Decrypting Key] (the same as the encrypting key of this backup set)

		  viii.Press the [Start] button

6.3 Restrict restoring files by IP addresses 

	 Online file restoring operation can be restricted by IP addresses. You can ask your backup provider to 	 	
	 restrict online file restoring for your backup sets by IP addresses to allow people from authorized IP 	 	
	 addresses to restore files from the backup server. To check if online file restore of any backup set is 	 	
	 restricted this way, please take a look at the web interface of DataMate, [Online Backup Services 			 
	 Management Console] -> [Backup Set] -> [Online Restore IP restriction] (shown below).

	 Users are not allowed to update the [Online Restore IP restriction] directly. Please ask your backup services 	
	 provider to do the changes for you.
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7 In-File Delta Technology
	 The chapter describes what in-file delta technology is and how in-file delta can be used to backup large 	 	
	 database files (e.g. a 10GB Outlook.pst file) without uploading the whole database file everyday.

7.1 Overview

	 In-file delta technology is an advanced data block matching algorithm which has the intelligence to pick 	 	
	 up changes (delta) of file content between two files when one of the files is not accessible and use the delta 	
	 information between two files to rebuild one file from the other. Using this algorithm, daily backing up of 	 	
	 large file (e.g. a 10GB Outlook.pst file) over low-speed internet connection is made possible because it 	 	
	 requires only the changes of information (should be marginal) since last backup (or last incremental backup) 	
	 to be sent over a low-speed internet connection to complete the backup of a large file (here we assume that 	
	 the full backup of the file has been saved on the backup server already). 

	 This is what would happen to the backup of a 10GB Outlook.pst file when it is backed up by DataMate 	
	 with in-file delta technology.

	 	 i.	 The whole files (10GB), along with its checksum (128-bit) file, are backed up to the backup server. This 	
			   can be done directly through the internet or indirectly using the seed loading utility on a removable 		
			   hard disk.

		  ii.	 When backup runs again later (normally the next day), DataMate will download a checksum listing of 		
	 	 	 all data blocks of the full backup file (or last incremental backup file) from the backup server and use it 	
	 	 	 to pick up all changes that have been made to the current Outlook.pst file from the first full backup.

	 	 iii.	Changes detected are then saved in a delta file which is uploaded to the backup server. (This delta 	 	
	 	 	 file is assumed to be small because the content of all PST files doesn’t change lot of even after it has 		
			   been 	updated) 

	 	 iv.	Subsequent backups of this 10GB Outlook.pst file will go through step ii and step iii again. As 	 	
	 	 	 explained, only a small delta file will be uploaded to the backup server.

	 	 v.	 With in-file delta technology, daily backing up of large file over low-speed internet connection is now 		
			   possible

	 Incremental in-file delta type
	 Example 1: If you are adding 200MB to Outlook.pst everyday, everyday after the first full backup job, 	 	
	 DataMate will detect what has been added since last daily backup and upload only 200MB of delta 		
	 file to the backup server everyday. This will go on until Day 100 because it is the [Maximum number of 	 	
	 delta] (default) allowed in this backup set and the whole Outlook.pst file will be uploaded again. You can set 	
	 the [Maximum number of delta] setting to [Unlimited] if you don’t want to upload the full file again.

	 All delta files are generated with respect to changes made since the last incremental backup. This means	 	
	 that the last full backup file and ALL incremental delta backup files are required to restore the latest 	 	
	 snapshot of a backup file. 

	 The full backup file, its checksum file and all incremental delta files stored on the server are always stored in 	
	 the data area. This means that these files are not affected by the setting of the retention policy and will 	 	
	 always be kept on the backup server. This is done this way because all these files are required to get the 	 	
	 latest snapshot of the backup file and they should not be removed from the backup server by the retention 		
	 area cleanup routine.
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	 Differential in-file delta type
	 Example 1: If you are adding 200MB to 10GB Outlook.pst everyday, the first delta backup will upload a 	 	
	 200MB delta file and the next delta backup will upload another 200MB delta file. This will go on until Day 	 	
	 50 when the delta file required to be backed up reached 10GB. This delta file size (10GB) is now is 50% of 		
	 the Outlook.pst that is 20GB (remember that you have added 100MB to this file everyday). If the [Delta Ratio] 	
	 is set to be 50% (default), the whole Outlook.pst file will be uploaded again.

	 Example 2: If you are adding 50MB to a 10GB Outlook.pst everyday, the first delta backup will upload a 	 	
	 50MB delta file and the next delta backup will upload a 50MB delta file. This will go on until Day 100 	 	
	 because it is the [Maximum number of delta] (default) allowed in this backup set and the whole Outlook.pst 	
	 file will be uploaded again.

	 All delta files are generated with respect to changes made since the last full backup file (i.e. differential 	 	
	 backup). This means that only last full backup file and the last delta file are required to restore the latest 	 	
	 snapshot of a backup file. This means that other intermediate delta files are only required if you want to 	 	
	 restore other snapshots of a backup file.

	 Differential in-file delta backup has the benefits that a corrupted delta file would only make one particular 	 	
	 version of a backup file non-recoverable and all other backups created by other delta files of the same file 	 	
	 would still be intact.

	 The full backup file, its checksum file and the last delta file uploaded (if more than one delta files have been 	
	 uploaded to the backup server) is always stored in the data area. This means that these files are not affected 	
	 by the setting of the retention policy and will always be kept on the backup server. This is done this way 		
	 because all these files are required to get the latest snapshot of the backup file and they should not be 	 	
	 removed from the backup server by the retention area cleanup routine. All other intermediate delta files are 		
	 stored in the retention area.

7.2 Block Size

	 The block size defines the size of data block being used to detect changes between last full backup file and 	
	 the file sitting on the local computer right now. In general, the smaller the block size, the more likely a 	 	
	 matched data block can be found between the last full backup file and the file on local computer. It, 	 	
	 therefore, produces in a smaller delta file but it would require more processing power to detect these 	 	
	 changes. On the other hand, in-file delta backup running with larger block size will run faster but this will 	 	
	 generally produce a larger delta file.
	 In most case, the default setting [Auto] will choose the optimal block size for each file (depending on the size 	
	 of the file) for you.

7.3 Minimum File Size

	 The [Minimum File Size] setting defines the smallest file size a file must have before the use and application 	
	 of in-file delta backup technology. 
	 If the size of a file that is being backed up is smaller than the [Minimum File Size] setting, in-file delta backup 	
	 technology won’t be applied to this file and the whole file, instead of just the delta file, will be uploaded to 	 	
	 the backup server. It is not necessary to perform in-file delta backup on small files because backing up the 		
	 whole file doesn’t take too long anyway. Backing up the whole file instead reduces the time required to 	 	
	 restore a backup file.
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7.4 Uploading full file again

	 No. of Delta
	 The [No. of delta] setting defines the maximum number of delta files from the same full backup file to be 	 	
	 generated and backed up to the backup server before a full backup (the whole file) of this file is uploaded to 	
	 the backup server instead. 

	 For example, if you have created 100 delta files from the full backup file already and the [No. of delta] setting 	
	 is 100, the next backup will upload a full backup file (the whole file) instead of just the delta file. However, 	 	
	 if the [No. of delta] setting is unlimited, it will keep generating delta files and uploading these delta files to the 	
	 backup server until any of the other delta setting conditions force a full backup (e.g. delta ratio is exceeded). 	
	 This setting is here to make sure that there will always be a full backup file after a certain number of delta 	 	
	 files have been generated.

	 Delta Ratio
	 The [Delta Ratio] setting is defined to be the size of a delta file divided by the size of its full backup file (i.e. 		
	 the percentage of changes detected between the last full backup file and the current file). 

	 If delta ratio calculated from the size of the generated delta file and the size of the full backup is greater than 	
	 the [Delta Ratio] setting, the whole file, instead of just the delta file, will be backed up to the backup server. It 	
	 is done this way because the difference between backing up the whole file and the delta file is not significant 	
	 and it is better to upload the whole file instead to reduce the time required to restore the file.

	 The default setting of [Delta Ratio] is 50%. This means that if more than 50% changes have been detected, 	
	 the whole file, instead of just the delta file, will be backed up and uploaded to the backup server. 

7.5 Advanced In-file delta type

	 The [In-file delta] -> [Advanced] setting allows user to override default in-file delta type when on a certain 	 	
	 number of days (e.g. all Sundays or the 1st day of each month). This is useful if you want all in-file delta 	 	
	 backups to be incremental but you always want to do full backup on Sundays as well as the 1st day of every 	
	 month. If you want to do this, simply configure [In-file delta] -> [Advanced] -> [Advanced In-file Delta Type 	 	
	 Setting] to what is shown below. 

	 With this setting, all backup jobs starts on Sundays or the 1st day of each month will run a full backup job. 		
	 In this case, all backup files which have been backed up incrementally/differentially using in-file delta feature 	
	 will be uploaded in full again. This ensures that all backup files will be backed up in full at a regular interval. 	
	 One benefit of this is that restore time will run faster because of less delta merging. Another benefit is that 	 	
	 the risk of a corrupted incremental delta file resulting in data loss is much lower because a full backup is 	 	
	 always available periodically.
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8 Backup/Restore Windows System State
	 This chapter will describe in details how to use DataMate to backup Windows System State and how you 		
	 can restore your Windows System State from backup.

8.1 Requirements

	 	 i.	 Microsoft Windows NT / 2000 / XP / 2003

		  ii.	 DataMate must be installed onto the computer containing the system state you want to backup

	 	 iii.	Windows system state will be backed up to a temporary file before it is sent to DataMate. Please make 	
	 	 	 sure you have sufficient space on your computer to store the temporary file when you run the backup 	
			   job.

8.2 Overview

	 DataMate will backup your Microsoft Exchange Server by taking the following steps:

		  i.	 Run all Pre-Commands of this backup set

	 	 ii.	 Windows System State will be backed up to a temporary directory specified in its backup set

		  iii.	Run all Post-Commands of this backup set
	
	 	 iv.	Upload the Windows System State backup files from the temporary directory to an DataMate Server

	 	 v.	 Remove the Windows System State temporary backup files from the temporary directory if [Setting] -> 	
	 	 	 [Temporary Directory for storing backup files] is enabled

8.3 How to backup Windows System State

	 Please follow the instructions below to backup Windows System State using DataMate:

		  i.	 Open DataMate

		  Right click DataMate icon available in the system tray and choose [Open] 

		  ii.	 Create a backup set 

		  From the Menu, Choose [Backup Set] -> [New] -> [System State Backup Set]

			   a.	 From the Menu, Choose [Backup Set] -> [New] -> [System State Backup Set]
			   b.	Enter a name for your backup set
	 	 	 c.	 Use the [Change] button to configure the [Temporary directory for storing backup files] setting and 		
	 	 	 	 check the [Remove temporary files after backup] if you want temporary files to be removed 	 	
				    automatically after backup
	 	 	 d.	Enter a temporary directory for storing the backup files before they are sent to an DataMate Server
			   e.	 Set the backup schedule for this backup set
			   f.	 Set the encryption algorithm, encryption mode and encrypting key for this backup set



B A C K U P  S E R V I C E S

S E C U R E  O F F S I T E  D A T A  B A C K U P

User’s Guide v2.01

DataMate Backup Services Pty Ltd - January 22, 2008 24

		  (Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, CBC (Cipher 	
		  Block Chaining) mode and use an encrypting key with more than 8 characters.)

		  iii.	Run Backup 

			   a.	 Select the backup set you want to run on the left panel and press the [Start Backup] button (?)
	 	 	 b.	Select [Off-site Backup Server] to start backing up your files to an DataMate Server and press the 		
				    [OK] button
			   c.	 You should get something similar to the screen shot below.

8.4 How to restore Windows System State

	 Please follow the instructions below to restore Windows System State from an DataMate Server. 

		  i.	 Install DataMate (if required)

		  Please refer to the [Installation] section for information on how to install DataMate onto your computer.

		  ii.	 Restore the Windows System State Backup File (i.e. SystemState.bkf) from the backup server

	 	 iii.	Use [NTBackup.exe] to restore your Windows System State to its backup time from the backup file by 	
			   following the instructions below:

			   a.	 Run [NTBackup.exe] from [Start] -> [Run]
			   b.	Press the [Restore Wizard] button and then press the [Next] button
	 	 	 c.	 Press the [Import] button and use the [Browse] button to select the backup file [SystemState.bkf] 	 	
				    downloaded
	 	 	 d.	Select the checkbox next to the description that matches your backup file
			   e.	 Press the [Next] button and then the [Finish] button

		  iv.	Completed
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9 Email Reporting
	 DataMate Server makes use of the email system to keep you informed with the status of your backup 		
	 activities. Please make sure your contact information within the backup system is correct to receive the 		
	 reports described in this chapter.

9.1 New User Report

	 When a new backup account is added to the backup server, a new user report will be delivered to the 		
	 contact email(s) of the new account. The New User Report contains the following information: 

Key Description

Login Name   Login name

Password Password

Alias Alias

Language Preferred Language for your backup report

Contact Email Address that will be used to contact you

Backup Quota Backup quota

Backup Server Backup server

9.2 Forgot Password Report

	 If you have forgotten your password, you can use the [Forgot Password] feature available on the web 		
	 interface to have your password delivered to you through email. (Please refer to “Retrieve Forgotten 		
	 Password” section in the next chapter for more information on how to retrieve your forgot password report.) 	
	 The Forgot Password Report contains the following information: 

Key Description

Login Name   Login name

Password Password

Alias Alias

Language Preferred Language for your backup report

Contact Email Address that will be used to contact you

9.3 Backup Job Report

	 For each backup job you have run, a backup job report will be sent to you by email. This report contains 		
	 a summary for the backup job that was run and a full listing of all files being backed up by the backup job. 		
	 The backup summary report contains the following information: 
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Key Description

Backup Time The time when the backup job ran

Backup Status
The overall status of the backup job. Normally, you should see “Backup finished 
successfully” in this field. If you happen to get something else, please consult the 
attached full report for more information.

New Files Total number and size of backup files added to your backup set

Updated Files Total number and size of backup files updated in your backup set

Deleted Files Total number and size of backup files deleted from your backup set

Moved Files Total number and size of backup files relocated in your backup set

Login Name Login name

Alias Alias

Language Preferred Language for your backup report

Contact Email Address that will be used to contact you

Backup Source All files/directories that will be backed up

Backup Data Size The total backup data stored in the data area

Retention Area 
Size

The total backup data stored in the retention area. Old copies of updated or 
deleted backup files are retained in the retention area for the number of days as 
specified by the retention policy of the backup set before they are removed from 
the system.

Backup Quota Backup Quota

Remaining Quota Remaining Quota

	 The full backup report, which contains a full listing of all files backed up by the backup job, is attached to 	 	
	 the backup job report email as a zip file. You need to unzip it before you can read the full report. 

Key Description

Backup Set The name of the backup set

Backup Job The name of the backup job (which is the start time of the backup job)

Backup Status
The overall status of the backup job. Normally, you should see “Backup finished 
successfully” in this field. If you happen to get something else, please consult the 
attached full report for more information.

Backup Time The time when the backup job ran

Backup Log All messages logged when running this backup job

New Files Total number and size of backup files added to your backup set

Updated Files Total number and size of backup files updated in your backup set

Deleted Files Total number and size of backup files deleted from your backup set

Moved Files Total number and size of backup files relocated in your backup set
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New File List Full list of all backup files added to your backup set

Updated File List Full list of all backup files updated in your backup set

Deleted File List Full list of all backup files deleted from your backup set

Moved File List Full list of all backup files relocated in your backup set

9.4 Setting Change Report

	 After you have updated your user profile or backup setting, a setting change report will be sent to you. This 	
	 report allows you to track record of the changes that have been made to your backup account. 

Key Description

Login Name Login name

Alias Alias

Language Preferred Language for your backup reports

Contact Email Address that will be used to contact you

Backup Quota Backup Quota

Backup Source(s) All backup sources of the backup set

Backup Schedule(s) All backup schedules of the backup set

Filter(s) All backup filters of the backup set

Retention Policy The retention policy of the backup set

Transfer Size The transfer block size of the backup set

Pre-Command(s) All Pre-Command(s) of the backup set

Post-Command(s) All Post-Command(s) of the backup set

9.5 Inactive User Reminder

	 You will receive an inactive user reminder in email if your account has been left inactive for the period of 7 		
	 days (or the period specified by the system administrator). This is to remain you that you have not 	 	 	
	 been running backup for more 7 days. If you are a free trial user, your account will be removed from the 		
	 system automatically if the system can track no records of your backup activities in the next 30 days after 		
	 receiving this report. 

Key Description

Login Name Login name

Alias Alias

Language Preferred Language for your backup reports

Contact Email Address that will be used to contact you
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Backup Quota Backup Quota

Last Login Time The last time you logon to the backup system

Last Backup Time The last time you ran a backup job 
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10 Web Features
	 Other than the features of DataMate described in the previous chapter, the web interface of DataMate Server 	
	 provides you access to some additional features that are not available in DataMate. This chapter describes 	
	 each of these features in details.

10.1 Install DataMate

	 Before you can use DataMate, you have to use the web interface of DataMate Server to install DataMate 		
	 onto your computer. Please refer to the installation section (Chapter 2) for information on how to install 		
	 DataMate onto your computer.

10.2 Update User Profile

	 You can update your user profile by using the [Profile] panel available on the web interface. To change your 		
	 profile, just make any changes to your profit on the panel shown below and press the [Update] button. 

Key Description

Quota Backup Quota

Data Area Total number and size backup files stored in the data area

Retention Area Total number and size of backup files stored in the retention area

Total Upload Total number and size of backup files uploaded to the backup server

Total Restore Total number and size of backup files restored from the backup server

Login Name Login name

Display Name Alias of your backup account

Language Preferred Language for your backup report

Time Zone Your Time zone

Contact Email Address that will be used to contact you

10.3 Request Forgotten Password

	 If you have forgotten your password, you can retrieve it by simply entering your login name or your 			
	 registered email address on the [Password Request] form and press the [Request] button. Your password 		
	 will be sent to your registered email address automatically.  

10.4 Delete/Undelete Backup Files

	 In addition to reviewing your backup activities from the email report and from DataMate, you can also review 	
	 any of your backup jobs by using the [Report] panel available on the web interface. To review a backup job, 	
	 just select the required backup job from the [Backup Set] and [Backup Job] drop down list. 
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10.5 Review Backup Jobs

	 In addition to reviewing your backup activities from the email report and from DataMate, you can also review 	
	 any of your backup jobs by using the [Report] panel available on the web interface. To review a backup job, 	
	 just select the required backup job from the [Backup Set] and [Backup Job] drop down list. 

Key Description

Job Status
The overall status of the backup job. Normally, you should see “Backup finished 
successfully” in this field. If you happen to get something else, please click the 
[Detailed Report] images on the page.

Backup Time The time when the backup job ran

New Files Total number and size of backup files added to your backup set

Updated Files Total number and size of backup files updated in your backup set

Deleted Files Total number and size of backup files deleted from your backup set

Moved Files Total number and size of backup files relocated in your backup set

Backup Data Size The total backup data stored in the data area

Retention Area Size

The total backup data stored in the retention area. Old copies of updated or 
deleted backup files are retained in the retention area for the number of days as 
specified by the retention policy of the backup set before they are removed from 
the system.

Total Upload Total number and size of backup files uploaded to the backup server

Backup Quota Backup Quota

Remaining Quota Remaining Quota

	 You can open the [Full Backup Report] to review all information logged by a backup job by clicking the 		
	 [Detailed Report] image on the [Report] panel. 

Key Description

Backup Set The name of the backup set

Backup Job The name of the backup job (which is the start time of the backup job)

Backup Status The overall status of the backup job.

Backup Time The time when the backup job ran

Backup Log All messages logged when running this backup job

New Files Total number and size of backup files added to your backup set

Updated Files Total number and size of backup files updated in your backup set

Deleted Files Total number and size of backup files deleted from your backup set

Moved Files Total number and size of backup files relocated in your backup set

New File List Full list of all backup files added to your backup set

Updated File List Full list of all backup files updated in your backup set
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Deleted File List Full list of all backup files deleted from your backup set

Moved File List Full list of all backup files relocated in your backup set

10.6 Review Storage Statistics

	 You can review the amount of data you have stored on the backup server and uploaded to the backup 		
	 server on each day by opening the [Statistics] panel available on the web interface. To review your storage 		
	 statistics for a different month, just select the month you are after by selecting from the [Month] drop down 		
	 list. 

Key Description

Date The date the following statistics are collected

Data Area Total number and size of backup files stored in the data area on a particular date

Retention Area
Total number and size of backup files stored in the retention area on a particular 
date 

Uploaded Size
Total number and size of backup files uploaded to the backup server on a 
particular date

Total Storage
Total number and size of backup files stored under your backup account on a 
particular date
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11 Further Information

11.1 FAQs 

	 Please see if your question has already been answered in our FAQs available on our website.

11.2 Contact Us 

	 You can backup your data to an DataMate Server by following instructions below.

		  i.	 Open DataMate from the system tray

		  ii.	 Choose [View] -> [About] from the top menu

		  iii.	Contact


